
File Manager Jr.
For Version 6.0 of Microsoft® Word for Windows™

File Manager Jr. comes in a smaller package than the Windows File Manager but 
performs many of the same functions.  Only faster.

Using File Manager Jr., you can quickly move, copy, delete and rename files 
without having to switch to the Windows File Manager.  You can also open 
existing files, delete all BAK files in a specified directory and print documents 
without opening them.  You can create, rename and delete Word directories.  And
you can recover deleted documents (if you have MS-DOS 6 or 6.2).

When you first start File Manager Jr., you see a display of Directory/Drive 
buttons and Command buttons.  Before being customized by the user, the main 
menu looks something like this:

In this initial configuration, the only directory name displayed is that of the main 
Word directory.  (The name WINWORD is used as an example.)  The remaining 
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thirty-five directory positions are open.

You can assign your own Word directory names to some or all of the thirty-five 
vacant positions.  You can fill open positions with names of Word directories you
have already created, or with names of directories you create using File Manager 
Jr., or with some of each.  If directory names were assigned to positions 2 through
14, the main menu might look something like this:

Working with the modified main menu would be simple.  Examples:

· To open a file stored in the LETTERS directory, you would first select 
Directory/Drive button number 2 and then choose the Open button.  A 
file list would appear so that you could select the document to be opened.

· To delete a file stored in the REPORTS directory, you would first select 
Directory/Drive button number 3 and then choose the Delete button.  A 
file list would appear so that you could select the document to be erased.

· To rename a file stored in the ARTICLES directory, you would first select 
Directory/Drive button number 4 and then choose the Rename button.  A file 
list would appear so that you could select the document to be renamed. 

Assigning directory names to the main menu is easy.  Directions appear later in 
this guide.

Seventeen commands are available on the main menu.  Fourteen perform 
functions related to file management.  The rest simplify other operations.  You 
can use File Manager Jr. to manipulate documents in as many as three dozen 
directories (and on two floppy disks).
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Typographic conventions used in this guide
Names of File Manager Jr. commands appear in boldface.  Filenames and 
directory names appear in small capitals.  Words that the user is to type in dialog 
boxes appear in small bold capitals.  Section titles are boldfaced when cited in the
text.

More about the main menu
Three columns of Directory/Drive buttons appear on the left side of the screen 
(see page 2) .  You can use a mouse to select a Directory/Drive button.  Or, if 
you’d rather keep both hands on the keyboard, you can use a number key to 
highlight the proper button.  Examples: 
· Press the 5 key once to select directory number 5.

· Press the 5 key twice to select directory 15.

· Press 5 three times to select directory 25.  (It will take you about a second.)

To the right of the Directory/Drive buttons are two columns of commands.  
Commands in the first column share a box with the Directory/Drive buttons and 
are used in combination with those buttons.  An example given earlier shows how
this works: To open a file stored in directory number 2, first select 
Directory/Drive button number 2.  Then choose Open in the first column of 
commands.

Commands in the column at the far right are in a free-standing box and operate 
independently.  They are not affected by the Directory/Drive buttons.  To run one
of these commands, simply choose the button identifying the command.  (If you 
inadvertently select a directory or drive before choosing a button at the far right, 
nothing will go wrong.  File Manager Jr. will ignore the Directory/Drive 
selection.)

Why more than one directory?
File Manager Jr. is designed to make it easier to work with Word when 
documents are stored in two or more directories.

Some users new to word processing may be unfamiliar with the use of multiple 
directories for document storage.  The practice is sometimes compared with the 
use of multiple folders in file cabinets.

It’s possible to stuff a thousand documents into one massive folder in a file 
cabinet, but using multiple folders with labels makes more sense.  Similarly, you 
can use Word for Windows with only one document directory, but such an 
approach is unsystematic.  Files are not logically grouped.  Letters, memos, 
manuscripts and other documents wind up in one ever-expanding heap.  It’s like 
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cramming everything into one folder in a file cabinet.  Unless you normally have 
only a few documents to deal with, using multiple directories will make for 
greater efficiency.

Assigning Word directories
Before using File Manager Jr., you’ll need to supply the names of any Word 
directories you have already created for document storage.  The program assigns 
the names of your Word directories to the File Manager Jr. directory list.

As used in this guide, the term “Word directories” refers to directories created as 
branches of the main Word directory.  Examples: C:\WINWORD\LETTERS and C:\
WINWORD\REPORTS would be branches of the main directory.  Strictly speaking, 
they would be Word subdirectories.  The term “Word directories” is used for 
short.  (Word’s home directory is always referred to as “the main Word 
directory” or “the main directory.”)

If you have not yet created any Word directories, skip the rest of this section.  
You can later create Word directories as needed, using the Directory Mgr. 
command.

If you have Word directories to assign, follow this procedure:
1. On the main menu in File Manager Jr., choose the Setup button (at the lower 

right).

2. In the Setup dialog box, choose the Assign Word Directories button.

3. In the next box, type the name of the first Word directory you want to assign. 
Do not type a path in front of the name.  Example: If you’re assigning a 
directory called C:\WINWORD\LETTERS. just type LETTERS.  Then choose 
OK.

4. Answer Yes or No when asked if you want to assign another directory.  If you
answer Yes, a new box appears.  Enter a directory name.  Example: To assign
a directory called C:\WINWORD\REPORTS, type REPORTS.  Then choose OK.

Continue until all your directories have been assigned or until you have exhausted
the supply of directory buttons.  If you run out of directories to assign before 
using all available buttons, answer No when asked whether to assign another 
directory.

Directory names appear on the main menu in the order you assign them.  The first
name you assign occupies the number 2 position, just below the name of the main
Word directory.  The next directory name occupies the number 3 position, and so 
on. 

Important: The Assign Word Directories command does not create directories. 
It merely lets File Manager Jr. know the names of Word directories you are 
already using.  To make a new directory, use the Directory Mgr. command.

You’ll probably need to run the Assign Word Directories command only once, 
to set up the program before you begin using it.  But if you later discover that you
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forgot to assign one of your Word directories, you can run the command again.

Note: MS-DOS won’t let you use certain characters in directory names.  File 
Manager Jr. disallows the following additional characters: the percent sign, the 
parentheses, the caret (^), the ampersand (&), the braces ( { } ) and the swung 
dash (~).

Caution
If a Cancel button is displayed in a File Manager Jr. dialog box, you can switch 
off the box by clicking the button or by pressing the Esc key.  But when a 
command is running and no Cancel button appears on the screen, do not try to 
stop the command by pressing Esc.  Doing so could corrupt the program code 
and make it necessary to reinstall File Manager Jr.

Using the commands
The Open command opens a previously saved file.  Specify the location of the 
file by selecting a Directory/Drive button.  Example: If the file is stored in 
directory number 2, select Directory/Drive button number 2.  Then choose the 
Open button.  An Open File box appears, displaying a file list.  Select a filename 
and choose OK.

Note: A Back button appears in many File Manager Jr. dialog boxes, including 
the Open File box.  If you open that box by mistake, you can use the Back button 
to return quickly to the main menu.  Just click the button or press Tab and then B.
To close the box without redisplaying the main menu, click Cancel or press Esc.

If no file list appears in a box with a Back button, you can return to the main 
menu by pressing B without first pressing Tab.  But using the Tab-B combination
will still work.  To avoid confusion, you may want to use that combination 
routinely.

·

The Move command transfers a file from one directory to another.  It will also 
move a file to or from a disk in a floppy drive.  Specify the location of the file to 
be moved  by selecting a Directory/Drive button.  Then choose the Move button 
and follow onscreen directions.

After you move a document, a new Move File box appears so that you can move 
another document if you wish.  To close the box, choose Back or Cancel.

You can’t use the command to move an open document.

·

The Copy command creates a duplicate of a file and places the duplicate at a 
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specified location, leaving the source file undisturbed.  The command works 
much like Move.  One difference: You can copy an open document.

·

The Delete command erases a file.  Specify the location of the file to be deleted 
by selecting a  Directory/Drive button.  Then choose the Delete button and follow
the directions in the Delete File dialog box.

After you erase a file, the Delete File box reappears so that you can erase another 
file if you wish.  To close the box, choose Back or Cancel.

The command will not delete an open document.

·

The Delete BAK command erases all BAK files in a specified directory or on a 
specified floppy disk.  Select a Directory/Drive button and then run the 
command.

There must be no open BAK files in the targeted directory or drive.

·

The Undelete command recovers erased files, using the Undelete for Windows 
program in MS-DOS 6.0 or 6.2.  Select a directory or drive and then choose the 
Undelete button.  In the Microsoft Undelete window, highlight one or more 
filenames.  Then click the Undelete icon.  To close the Undelete window, hold 
down Alt and press F4.

To tell DOS what level of file protection you want to use, choose the Undelete 
icon from the Microsoft Tools group in the Windows Program Manager.

·

The Rename command changes the name of a file.  Specify the location of the 
file by selecting a Directory/Drive button.  Then choose the Rename button and 
follow the directions in the Rename File dialog box.

When you type a new filename, do not include a path.  Example: Don’t type C:\
WINWORD\MEMOS\DOCK.DOC.  Just type DOCK.DOC. 

After you rename one document, the Rename File box reappears so that you can 
rename another if you wish.  To close the box, choose Back or Cancel.

You can’t use the command to rename an open document.

·

The Print File command can be used to print any Word document in any 
directory, regardless of the directory you’re working in.  Example: You’re editing
a file in directory number 3 and need a printout of a file stored in directory 4.  
First select the number 4 Directory/Drive button.  Then choose the Print File 
button.  A list of the files in directory 4 appears.  Select a filename and choose the
Commands button in the lower part of the window.  On the Commands menu, 
choose Print (taking care not to choose Open Read Only instead).  When Word 

File Manager Jr. / 66



displays the Print dialog box, choose OK to start printing.

You can print more than one file by selecting more than one filename before 
choosing the Commands button.

The Print File command can perform a second function: Without printing 
anything, you can use the command to get information about files in a specified 
directory or on a specified floppy disk.  Example: You’re working on a file in 
directory 3.  The file DOCK.DOC is stored in directory 4.  You want to know the 
number of words and pages in DOCK.DOC.  Procedure: Select Directory/Drive 
button 4 and choose Print File.  Then highlight the name DOCK.DOC.  After 
checking the document statistics, press Esc to close the window.

·

The Save New command is used to specify where a file will be stored when 
saved for the first time.  Select a directory button before choosing the command.  
Example: If you want to store a file in the number 4 directory, select button 4.

When you type a name for a new file, do not include a path.  Example:  Don’t 
type C:\WINWORD\MEMOS\DOCK.DOC.  Just type DOCK.DOC.

The command cannot be used to store a new file on a floppy disk.

·

The Back Up command sends a copy of the active file to a backup disk in the A 
drive.  Any previous backup copy is overwritten.

If you want to use the B drive for backups instead of the A drive, run Setup and 
choose the Change Backup Drive button.

Note: Back Up is the first command in the far-right column on the main menu.  
Like other commands in that column, it is not affected by the Directory/Drive 
buttons.  To run the command, simply choose the Back Up button.

·

The Print Selection command prints a selected block of text.  First highlight the 
text you want to print.  Then choose the Print Selection button.

·

The Find File command is used to search for a Word document when you’re not 
sure where you stored the document or you’ve forgotten its name.  You’ll first be 
asked whether you want to search for a filename or for text.  If you know the 
name of the file you’re looking for, choose the Filename button.  Type a filename
in the next box.  If the file is found, its directory is identified.

If you don’t know the name of the file, choose the Text button.  When asked to 
enter text, type a phrase that is likely to be found only in the file with the 
unknown name.  Important: Enclose the phrase in quotation marks.  (See pages 
498 and 499 of the Word User’s Guide.)  Finding specific text takes longer than 
finding a filename.
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The Find command does not search floppy drives.

·

The File Info command displays a word count, a page count and other statistical 
information about the active file.

·

The Directory Mgr. command is used to create, rename and delete Word 
directories.  It can also be used to change the order in which directory names are 
displayed in the main File Manager Jr. dialog box.  For additional information, 
see More about Directory Mgr. later in this guide.

·

The Address List command places an inside address in a business letter.  The 
address is copied from a file in which you have stored names and addresses.  The 
command is also used to print envelopes and to edit, browse and sort the address 
file.  For additional information, see More about Address List later in this 
guide.

·

The Junk Closet command is used to store text temporarily in a holding file or to
retrieve text from the holding file.  For additional information, see More about 
Junk Closet later in this guide.

·

The Quit Word command closes any open documents and quits Word for 
Windows.  Use the command when you want to make a quick exit.  If any open 
documents have been changed since they were last saved, the changes are 
preserved.

Note: If you have entered text in a new document but have not yet named the 
document, you’ll be asked to supply a name before quitting Word.

More about Directory Mgr.
To set up a new Word directory, run Directory Mgr. and choose the Create 
button.  Then follow the onscreen directions.  The name of the new directory is 
assigned to the first open position in the File Manager Jr. directory list.

To change the name of a directory, first close any open document windows in that
directory.  Then run Directory Mgr. and choose the Rename button.  Follow the 
onscreen directions.  You can’t rename the main Word directory, but you can 
change any other directory name displayed in the File Manager Jr. directory list.

To erase a Word directory, first close any open files in the directory.  Then run 
Directory Mgr. and choose Delete.  If the directory you want to erase is not 
empty, File Manager Jr. displays a warning.  If you elect to proceed, all files in 
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the directory are erased.  Unless you are positive that the directory contains no 
files of value, you should cancel the command.

To change the order in which File Manager Jr. displays directory names on the 
main menu, run Directory Mgr. and choose Move.  One function of the Move 
command is to fill an opening created when a directory is deleted.  Illustration: 
You have 10 working directories.  If you delete directory number 5, File Manager
Jr. removes the directory name from the main menu, creating a missing-tooth 
effect in the directory list.  You can fill the gap by moving the name of another 
directory to the open position.  If a directory called KUMQUAT is in position 10 
and you’d like to move it to the vacant number 5 position, run the Move 
command and  type KUMQUAT in the first dialog box.  In the next box, type the 
number 5 to indicate that KUMQUAT is to be moved to position 5.

You can also use Move to transpose the names of two working directories.   
Example: The directory REPORTS is in position 3.  The directory MEMOS is in 
position 5.  You’d like them to switch places.  Procedure: In the first Move 
dialog box, type REPORTS.  In the next box, type the number 5.  When you 
choose OK,  REPORTS moves to position 5 and MEMOS takes the place of REPORTS
in position 3.

Note: When you enter a directory name while using any of the Directory Mgr. 
commands, do not type a path in front of the name.  Example: Don’t type C:\
WINWORD\BROCHURE.  Just type BROCHURE.

Important: After setting up File Manager Jr., use Directory Mgr. instead of the 
Windows File Manager to rename and delete Word directories.  Otherwise, File 
Manager Jr. will be unable to keep track of your directory names.  To save time, 
you should also use Directory Mgr. to make new Word directories.  If you create
directories with the Windows File Manager, you’ll need to run the Assign Word 
Directories command in Setup to let File Manager Jr. know the directory names.

More about Address List
When you choose Address List, you see a dialog box with four command 
buttons.  The first command is Copy.  It places an address block in a business 
letter, saving you the trouble of typing an inside address.  The block is copied 
from a file in which you can store frequently used addresses.  The file is called 
NAMELIST.FMJ.  It was placed in the main Word directory when you installed File 
Manager Jr.

To copy an address block, first place the insertion point anywhere on the top line 
of the body of your letter.  Then execute Address List and choose the Copy 
button.

You’ll be asked to type a name.  If you want to copy the address of an individual, 
type a surname.  If you want to copy a business address in which no individual is 
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named, type the first word in the name of the business.  Examples: If you’re 
writing to Horatio D. Blunt, type BLUNT.  If you’re writing to the law firm of 
Hussler & Hassler, type HUSSLER.  (You may be able to save keystrokes by 
typing only the first four or five letters of a long name.)

The style you use for letters does not have to match the style used to set up your 
address list in NAMELIST.FMJ.  If the styles are different, address blocks imported 
with the Copy command are converted to your letter style.

The second command in the Address List dialog box is Print Envelope.  If you 
have a business letter onscreen, you can use the Envelopes and Labels command 
on the Tools menu to copy the delivery address from the letter to an envelope.  
But sometimes you may be unable to use that command because you’re mailing 
material without a cover letter.  Solution: If the recipient’s name is in your 
address file, you can still print an envelope quickly.  Just choose Print Envelope 
in the Address List dialog box and follow onscreen directions.  

By default, the Print Envelope command uses the Courier typeface and does not 
print a return address on your envelopes.  You can change these defaults.  
Procedure: On the main menu in File Manager Jr., choose the Setup button.  In 
the Setup box, choose Envelope Setup.  You’ll be asked to select a font.  If you 
want a return address to appear on each envelope but don’t want to change the 
default font setting, select Courier as the typeface and 12 as the point size.  You’ll
next be asked if you want a return address printed.  If you answer Yes, Word will 
use whatever address it finds in your Mailing Address box.  To see what’s in that 
box, choose Options on the Tools menu and click the User Info tab.

The third command in the Address List dialog box is Edit/Browse.  Use it when 
you want to open the address file so that you can add addresses, delete addresses 
or just browse. When you choose Edit/Browse, you’re asked where you want to 
start in the address file.  Choose a letter.  The command searches for the first 
listing under that letter.

If you’re entering a new address listing, follow this form:

Blunt*Horatio D.
Blunt Instruments Limited
12345 Sixth Street
San Lardo, California 90000-0000
Mr. Blunt
408-000-0000

The person’s last name comes first.  Next comes an asterisk.  No space is left 
before or after the asterisk.  Do not use an asterisk anywhere else in a listing.  

When a listing is copied to a letter, File Manager Jr. rearranges the first line and 
removes the asterisk.  Like this:

Horatio D. Blunt
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Blunt Instruments Limited
12345 Sixth Street
San Lardo, California 90000-0000
Dear Mr. Blunt:

The “Mr. Blunt” in the salutation is copied from the next-to-last line of the 
Horatio Blunt address listing.  If that line were changed from “Mr. Blunt” to 
“Horatio,” the address would be copied with a “Dear Horatio:” salutation.  A 
name that can be used in a salutation must be entered on the next-to-last line of 
each listing.

The last line of each listing is reserved for a phone number and remarks.  
Example:

212-000-0000. Stanford grad. Birthday: 6/15. Wife: Gloria.

It’s OK to use more than one line for remarks, but the remarks must be confined 
to a single paragraph.  Do not press Enter between remarks.

If you don’t have a phone number for someone on your list and no remarks are 
needed, type several zeros on the phone-number line.  Do not omit the line.

When an abbreviation such as “M.D.,” “Esq.” or “Jr.” is used on the first line of a
listing, it is treated as part of the last name and is entered before the asterisk.

Correct form:
Flapdirdle, M.D.*Clyde C.

Incorrect form:
Flapdirdle*Clyde C., M.D.

If a last name consists of two or more words, the asterisk goes after the last of 
those words.  Example:

Van der Flatt*Vanessa C.
Chief Executive Officer
Van der Flatt Tire Corporation
700 Avenue of the Aleutians
New York, New York 10000-0000
Ms. Van der Flatt
212-000-0000

When a listing begins with the name of a firm rather than with the name of an 
individual, follow this form:

Hussler & Hassler*
Attorneys at Law
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Jarndyce Center
123 Fourth Street
Hacksaw, Texas 75000-0000
Counselors
509-000-0000

Notice that the asterisk appears at the end of the first line of the listing, after the 
name of the law firm.  (The full name of the firm is treated as a surname.)

A listing may run five to seven lines.  The Hussler & Hassler example runs seven.
Here is an example of a five-line listing:

Cartwright*Crispin C.
1234 Fifth Street
Bounding, Maine 04000-0000
Mr. Cartwright
207-000-0000

Important: Leave a blank line below each listing.

After entering one or more new listings, choose Close on the File menu and 
answer Yes when asked whether to save changes.  Follow the same procedure 
after deleting one or more listings.

Note: Eleven blank lines have been placed at the top of the address file.  They 
should not be removed.

Several fictitious address listings have been entered in the file for illustrative 
purposes.  They may be deleted.

The Edit/Browse command can be used to look up information in the address 
file.  Example: If you need the telephone number of Horatio Blunt, run Address 
List and choose the Edit/Browse button.  Then choose B.  The insertion point 
appears before the first listing under that letter.  After finding Blunt’s phone 
number, quit the address file by choosing Close on the File menu.

The last command in the Address List dialog box is Sort.  It alphabetizes address
listings.  When you add listings using the Edit/Browse command, you don’t need
to jump around in the address file to get each new listing in its proper alphabetic 
position.  It’s OK to enter listings in any order anywhere in the file (so long as 
you leave a blank line after each listing).  When finished, save the file and use 
Sort to put the listings in proper order.

Note: You don’t have to sort the address file before using the Copy command to 
place an inside address in a letter.  It makes no difference to Copy whether the 
address list is sorted or unsorted.  But a sorted list is easier to work with when 
you’re browsing.
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More about Junk Closet
The Junk Closet command is used for storage of text you want to remove from 
the active file but keep available for possible use later.

To store a block of text in the junk closet, first select the text.  Then run Junk 
Closet and choose Store Selection.  The text is sent to a file called JUNK.FMJ.  
The file was placed in the main Word directory when you installed File Manager 
Jr.

To retrieve text from the junk file, run Junk Closet and choose Open Closet.  A 
Find dialog box appears.  Type a word or phrase peculiar to the block of text 
you’re looking for.  Then press Enter.  If the junk file is small and you don’t need
to run a search, press Esc to close the Find box.

To retrieve a block of text, first select the text and place it on the Windows 
Clipboard.  Then choose Close on the File menu and answer No when asked 
whether to save changes in the junk file.  Finally, copy the text from the 
Clipboard to the active file.

When you open the junk file, text in that file is displayed in whatever style you’re
using in the active document.  That means you won’t need to apply your current 
style to text imported from the junk closet.  The style will already have been 
applied.

The Junk Closet command places a separator mark before each block of text 
stored in the closet.  That makes it easy to tell where one block ends and the next 
begins.

To delete text from the junk file, first execute Junk Closet and choose Open 
Closet.  Then select the text you want to erase and press the Delete key.  Choose 
Close on the File menu and answer Yes when asked whether to save changes.

Assigning File Manager Jr. to a shortcut key
1. On the Tools menu, choose Customize.

2. In the Customize dialog box, click the Keyboard tab (at the upper right).   

3. In the Categories list box, click Macros.

4. In the Macros list box (to the right of Categories), click FileMgrJr.

5. Click the box labeled Press New Shortcut Key.  Press a shortcut key or a 
shortcut-key combination.  Example: If you want to be able to start File 
Manager Jr. by holding down Ctrl and striking J (for “Junior”), press the 
Ctrl key and, without releasing it, press J.

6. Choose Assign.

7. Choose Close.
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·
Assigning File Manager Jr. to a toolbar button
· On the Tools menu, choose Customize.

· In the Customize dialog box, click the Toolbars tab (at the upper left).

· In the Categories list box, click Macros.

· In the Macros list box (to the right of Categories), click the name FileMgrJr. 
and keep the left mouse button depressed.  A rectangular outline appears.  
Drag the outline to a position on the toolbar and release the mouse button.

· In the box labeled Text Button Name, type a short name, such as JR.

· Choose Assign.

· Choose Close.
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Terms of use
File Manager Jr. is a shareware program protected by copyright.  You can register
your copy of the program by paying a fee of $15.  (Idaho residents: Add sales 
tax.)  Please send your payment to:

Charles Maher
409 North 18th Street
Coeur d’Alene, Idaho 83814-5460

Registered users who have questions about the program may write or call the 
author (208-664-3864).  Questions will be answered without charge.  Registered 
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users will be notified of any upgrades and will be entitled to discounts on upgrade
registrations.

For more about terms of use, see the file LICENSE.FMJ in the main Word directory.
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